PDF to FlashBook
Standard

Create your flipping book from PDF files




PDF to Page-Flipping eBook Utility
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About PDF to FlashBook Standard

PDF to FlashBook Standard is your easy way to
batch convert ordinary PDF files into stunning
booklets with amazing page-flipping animations
and sound! Imagine being able to create digital
magazines and catalogs that behave like actual
paper books without any programming work! Once
you've created your page-flipping masterpiece in
PDF to FlashBook Standard, you can publish it to
the web, via email, and even distribute it on

CD-ROM, all without paying royalties!

Note: This product is distributed on a "Try
before-you-buy" basis. All features described in this
documentation are enabled. The registered version
doesn't insert a watermark in your generated

page-flipping eBooks.
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Product features

1

2.

8.

9.

Convert PDF to Adobe© Flash® based page-flipping eBooks.

Output in 4 different formats: HTML, EXE, Zip and Burn to CD.

. HTML allows you to upload to a website to be viewed online.

EXE and Zip allow you to send to your user by email to be viewed

on their computer.

. Burn to CD allows you to burn to disk so you can send your user

physical media for viewing on their computer.

Preview the output effect instantly.

Batch convert multiple PDF files to a single or multiple
page-flipping eBooks.

Import bookmarks (outline) with PDF, and edit them manually.

Import hyperlinks with PDF, include web link, page link, email link.

10.Import text with so text is searchable.

11.Provide multiple templates (default provided or download from

website).

12.Set eBook size, choose landscape or portrait.

13.Add watermarks text, image, dynamic date/ time etc to

page-flipping ebooks.

14.Define titles, keywords and other metadata.
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15.Define titles, icon, window size for EXE page-flipping ebooks.

16.Define book margin size manually.

17.Add encryption to protect created page-flipping eBooks.

18.Retain the book to center or not.

19.Insert background music, always play or define times.

20.Set background color and image.

21.Set book reading from right to left (such as Arabic).

22.Choose hard cover for eBooks.

23.Set page-flipping time manually.

24.Customize toolbar buttons to set permissions for downloading,
printing, sharing and more.

25.Set colors for toolbar, book cover, book shadows, bookmarks and
more.

26.Set scale for zoom-in function.

27.Set control bars to "show" or "hide" in full screen.

28.Define language for flash.

29.Export and save settings for future uses.

30.Set output name mode within batch conversion.

31.Save current files and settings as project.

Copyright 2010 by FlashBookMaker.com
-3-



PDF to Page-Flipping eBook Utility

t

—

e \V,}--' User Document

Page-flipping eBook features

With the page-flipping ebook you have created, your user will be able to:
1. Drag the corner to flip a page.
2. Click page shadows to flip a page.
3. Input login password to view eBook content.
4. Auto-view flipbook repeatedly.
5. Auto-flip eBooks after loading.
6. View page thumbnails.
7. Use button to control page, such as Previous, Next, First, Last etc.
8. Flip pages automatically.
9. View page-flipping ebook full screen.
10.Search whole eBook.
11.Print out the whole ebook or a range of pages directly.
12.Download the uploaded page-flipping eBook from web site directly.
13. Double-click to zoom in or zoom out.
14.Zoom in/ out both pages.
15.Share eBook url via email.
16.0pen or close page-turning sound.
17.0pen to a certain page in Browser by adding a suffix like this:

index.html?pagelndex=4.
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Quick Start

e

v

1. Launch the application via the desktop shortcut =i,

 1.Add Flie
2. Click the "1. Add File" Tab icon “' to enter

into Import PDF interface;

3. Click L#®**= licon to choose PDF file from your computer;

4. Click icon to enter into template setting

interface;

5. Define parameters for eBooks, such as Book, Tool Bar, Bookmarks, and

Apply Change
then click the "Apply Change" icon m ;

3. Publish
6. Click "Publish" Tab icon “i to enter into Output

interface;

7. Choose Output Type from HTML, ZIP and EXE, here take
'L_\_:E_':F}’ 2 x.htl'l'll
: as example;
8. Click L #?"*= |{5 set Output Folder as "C:\flipbook", input File Name
as "demo";

| Lonvert |

9. At last, click icon to output created page-flipping eBook.
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You can open the "flipbook" folder in "C:", there are three files in this folder:

5 @

files book.swf dema.html

Open the "demo.html" file to view your created pOOage-flipping book via Web
Browser, such as Internet Explorer, Google Chrome, Firefox, etc.

& demo - Windows Internet Explorer | B
QO ~.u|g C:\fliphook\demo.html 14| x ||[[= aing 2 -
< Favorites | < D .
| @ demo [ fi v B v g v Pagev Ssfetyw Tookw @+

FLir PDF

& Internet | Protected Made: Off da v H100%

Interfaces

There are some main interfaces you will see while using PDF to
FlashBook Standard as below shows: Application Options, Import PDF,

Template Settings, Language Option, Output, and Batch Convert.
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You can enter into each page to get clear instructions for every detail

option.

I. Application Options Interface

Render Engine Option

New version 3.0.0 provides 3 different render engines for you to create higher
quality page-flipping eBooks, click "Options->Application Options" to enter into
"Render Engine" interface:

Reendar Engane

Flease seleche a render engine for the conversion

e
EL"."F

L4
[ ]
GPL Ghosterript  Dgysioad Ghosteerint

@ [rmer Library

SViF: Miuch legble characters, smaler output siee
. Ghostsorpt: Higher cofor ransfer gualbty

Inner Library: Faster convert speed

o | [ come

SWF: Much legible characters, smaller output size
GPL Ghostscript: Higher color transfer quality
Inner Library: Faster convert speed

(Change option when PDF imported failed)
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Il. Import PDF Interface

1. Add Flie 2. Style J 3. Publish
4

Import PDF
C:‘u,l_lsersl;ﬁ.dmmisﬁ'amr'n,Deskhop'l,lZZ.pcif Browse.. I | Open it
Pag_e range to 'hrn_port Watermark
©) All pages o
(") Custom rage: Example:1,9-21,30 % o

&

L Set Watermark
| | Quidkly impart (Only import 10 pages to initial preview)

J Paggs q_uat[t_y and size

Quality And Size: lHigh quality large file size V]

M High values produce better page quality but require more disk space and more time to download.

~ Options

[7] tmport bookmark (] Impart links | |Enable search [/] Detect wide pages

Panel Description:
1. Source PDF File:

Click this icon to open the PDF file you want to convert;

Coonit View content of added PDF file to clarify before converting.

2. The Page Ranges to Import:

©&Ipag=s  Convert all pages to page-flipping eBook;

i@ Custn . 25 E :1,3,5,8-21 .
EEE e xample:1, Convert defined range page;

[V] Quickdy import {Only import 10 pages to initial preview) Just preview effect on first 10 pages

3. Watermark

Add image or text watermark to flipping pages.

Copyright 2010 by FlashBookMaker.com
-8-



PDF to Page-Flipping eBook Utility
i : Y
= B

User Document

Appiying Watermark Check this option first to choose default stamps or add new ones:

[ Add Text Watermark =2
A add Text Watermark

Text liame
Bamer Text Watermark

Text:  Page-ficpng eBlock Macre: -
TextPropertes.

gont: (@ reheses | [7lembedded tont

me oo I ()
Style: [ Boig 170 Dt nderine
TextLapout

P T —— | [ s badground
Clrie stie .67

Fostonnmarges  Margi
wow o Huesn

=== eem goht:
= E L] Bottom: 30 '
Text Effect
Qoadty: 0% i 0%

Edit / mlnu.n‘; :
Add lex! stamp lon °|

Add image stamp._i ssinse watemsi

Page-flipping eBook

B

Delete Irage tame

Move down : ]

P ¢ X B &

Move up S

4. Page Quality
There are five types of "Quality And Size":

Medium guality medium file size
Low guality small file size
Lower guality smaller file size

5. Other Options:

[V]use first page's width and height as page proportion Select this option to use first page's

proportion as book proportion, or you can define in Template Setting interface;

[} tmport bookmark If your PDF file contains bookmarks, check this option to use in output

page-flipping eBook;

7| mpart links If your PDF file has links, check this to enable in flipbook;

Enable search ook this option to enable search functionality in created flipbook.
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At last, click m icon to enter into template setting interface.

lll. Template Settings Interface

_ -
: LeihBook Srandard Unragisterad — : ST [P
[ DF o FlasiBook Standerd Unrsgistered — FIF to FlashBeck Stendard Ovarvies | - i e 2|
File Conwert D'Etions Hel_p_

1. Add Flie J 2. Style J 3. Publish J

Design Setting Bookmark:

Apply Change :
BlToolBarsSettings | *

T ——— e —
i . Themes = 18 ElHome Button
Catalog: Home Button Visible =
Templates:
Classical
Spread

T

Enable Sound
P LS SR

It provides three different templates at present: Classical, Float and Spread.
Each template contains some unique settings, the below instructions will

show you details.

The design setting interface contains below main parts:

Choose Template
Book

Sound

Tool Bar
Bookmark

Initial Show

Links
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-10-



= B

PDF to Page-Flipping eBook Utility

User Document

Language
Security Settings
Render Engine Option

Panel Description:

1. Choose Template:

i Themes
Catalog:

Templates

Classical

Spread

Click

Blank,

2. Book Panel:

icon to select templates from below interface:
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BlBook o

__Flash Window Color
...Page Background Calor | [ 10xfFHH
_Eage Shadow

RightToleft ~ ~  No
Flipping Time 0.6

(1) Book Title (only can be set in Float Template):

Customize book title for showing on the top of your flipbook.

(2) Hide Book Frame Bar:

| Hide Book Frame Bar |Yes hd|

If don’t want to show the book frame bar, choose “Yes” in this option.

(3) Retain the book to center:
| Retain the book to center |Yes B |
If you select “No” in this option, the eBook will be shown on the right-side. This setting is for

embedding special background image, such as advertisement or company log.

(4) Book Proportions:

Copyright 2010 by FlashBookMaker.com
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| BBook Proportions |
R G e B RO
Pagereht g

Please note that the values are not fixed in pixels or inches, they just represent a ratio for
"Page Width: Page Height", and the book size will be changed depend on your Explorer
Window Size.

(5) Book Margin:

A. Book Margin (set in Classical Template):

- BookMargm — !50 S

~Margin

= pn argin

"Book Margin" refers to the distance between the book and the toolbar.

B. Top/ Bottom/ Left/ Right Margin (set in Float/ Spread Template):

(6) Flash Window Color:
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This color will be applied on all flash windows, such as the book window, "Help" window,

"Print" window and so on.

(7) Icon Color (only in Classical Template):

| Icon Color

| JoxFrre =
7 Q — E

(8) Page Background Color:
_Page Background Color | I0XFFE040.

When load pages, or if the page number of your PDF file is odd, then the page (the last page)

will show with the "Page Background Color".

(9) Page Shadow:

. BlPage shadon ;
_Right page Shadow 25
Page Shadow Opadty 0.5

Lefe page Shadow

Right page Shadow

The value also takes the value of Book Proportions as reference, and the value interval of

"Page Shadow Opacity" is "0~1", the larger value refers to the deeper shadow color.
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(10) Background Config:

A. Background Color:

BeadgroundConfig [

... BBackgreund Color |
___ GradentColor A |[JOXFFFFFF
_ GradientColors | M0xo00000
Gradient Angle a0
Gradient Color A
e

Gradient Color B

Define background for your flipbook with gradient color or pure color (the same color for
"Gradient Color A" and "Gradient Color B"). Gradient Angle is the angle between the two
colors.

B. Background Image setting in Classical and Spread templates:

HBackground Image
Image File
Image position

Click the icon " =I" to choose background image from your computer, and there are 11 kinds
of "Image Position" for you to choose: Scale to fit, Fill, Top Left, Top Center, Top Right,
Middle Left, Middle Center, Middle Right, Bottom Left, Bottom Center and Bottom Right.

C. Background Image setting in Float template:

GlBackground Image |
| Outer Image File E:\Program.. |
Image position Scale o fit |

E:\Program.. |
|Scale to fit

The Float template enables you to add two background images: Outer Image and Inner
Image. You can make Inner background image to show special information, such as
advertisement or company logo, etc. There are also 11 kinds of "Image Position" for you to
choose: Scale to fit, Fill, Top Left, Top Center, Top Right, Middle Left, Middle Center, Middle
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Right, Bottom Left, Bottom Center and Bottom Right.

(11) Right to Left:
If the language of your file is read from right to left (such as Arabic), then choose "Yes" in
"Right to Left" option:

|. - R|ghtT0 |:E:|’-t' S .E\"ES' S

(12) Hard Cover:
If you want create hard cover effect (a book bound with rigid protective covers) for your
flipbook, choose "Yes" in "Hard Cover" option:

Hard Cover |Yes

(13) Flipping time:

_Flipping Time B sets page flipping time in seconds according to your

needs. (Recommended second value is 0.6)

3. Sound Panel:

[iberd e '
Enable Sound |Enable |
Sound File ||,|_-- = g___“
Sound Loops |-1

If you want to add background sound to your flipbook, such as a song or other audio file, set
"Enable Sound->Enable", then click " =]" icon to choose "Sound File" from your computer,
then set "Sound Loops", "-1" stands for playing the sound file all the time while viewing
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flipbook, other value (N>0) stands for the times of playing the sound file.

4. Tool Bar:

ElTool Bar !
Tool bar |Shaw
Bar Calor  0x000000
Icon Color | CIoxfFe
ElZoom Config !
Print Enable |Yes
 Search Button |Shaw
Search Highlight Color | C10xffff00
Download setting |
Full Screen Button |Shaw
Full Sereen Without Tool..., No
Help Button |Show
Elshare Button !
E Auto Flip |

(1) Tool bar (only in Classical Template):

o I Show or Hide Tool bar in created flipbook.

(2) Zoom Config:

HlzoomConfg [
L..Zeominensble | les
Zoom Scale 1.5

To Enable Zoon In functionality, choose "Yes" in "Zoon in enable", then set "Zoom Scale", the
value is the times between zoomed page size and the current page size.

(3) Print Enable:
cRiatEaE o Ve

Choose "Yes" in "Print Enable", then click icon to set print page range as below:
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& Print w

=) Print A1 Pages
_) Print Current Page
. Prnt Range

Example; 2 5.3-26

= Print

(4) Search Button:
Search Button Show
.....Search Highlight Color | [10xffFf00

Select "Show" in "Search Button" (make sure you have check "Enable Search" option in
"Import PDF" interface), then define "Search Highlight Color", after clicking "Search" icon

, you will see a popup box to input search words, then click Enter or "Search" button,

you will get the below searching result:

Wiy Choose Flip POF?

(5) Download setting:
E.D_quj-.'l.'nl.oa_d sethng
Download Enable Yes
[ Download URL 2DFDemo. pdf'

If you want your flipbook readers to download the PDF file or the flipbook directly from your
website, select "Yes" in "Download Enable" option, then input the Download URL directly,
you can use absolute path like
"http://www.FlashBookMaker.com/flip-pdf/example/files/download/FlipPDFDemo.pdf" or
relative path like "/files/download/FlipPDFDemo.pdf" (make sure you have uploaded the
PDF to the same path).

Then readers can click the icon n to download your uploaded PDF file directly.

(6) Full Screen:
To enable "Full Screen" functionality in output flipbook, select "Show" in "Full Screen

Copyright 2010 by FlashBookMaker.com
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Button" option: Full Screen Button Show

Then you can click icon E to view flipbook in Full Screen, click icon m or "Esc"

button to exit from the Full Screen.
Or if you want to show your flipbook without Tool Bar while showing in Full Screen mode,
you can set "No" in "Full Screen without Tool Bar" (just in Classical Template):

Full Screen Without Toaol.. | Yes

(7) Help Button:
To show tips about viewing flipbook, you can set "Show" in "Help Button" option:
Help Button Shaow

Then you can see the button and click to get the tips as below:
“7  Help S
'J Double click to room in or out

'ﬂ" Drag the page corner to view

(8) Share Button:
If you want your flipbook viewers to send the link to their friends or clients, you can add a
share button in your flipbook for readers to send out your flipbook link immediately:

Elshare Button .
Share Button Show
Email Subject Rear my fii...
Email Body finkX

When the viewers click the share button E, they will enter into the Email interface with

the link of your flipbook in the Email body.

(9) Auto Flip:

To auto flip your eBooks, you can set "Yes" in "Auto Flip->Enable" option; then define the
Flip Interval (seconds of staying on each page); the value of "Play Count" stands for the times
of auto playing the eBook, and "-1" stands for playing forever (after clicking the Auto Flip

button “, the flipbooks will be flipped by staying 3 seconds per page); if you want to

auto start and flip the eBook after opening, just set "Auto flip when start up->Yes":
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WL, A

... Enable

... Flip Interval
Auto flip when start up IYes

5. Initial Show (set in Float/ Spread Template):

You can show Bookmark panel or Thumbnails panel on the flash page at the beginning, just
select "Bookmark" or "Thumbnails" in this option:

For Example, select "Thumbnails": Linta show [Thumbris |

Then you will get flipbook shown with below initial interface:

FLir PDF

6. Bookmark:
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| ow000000 B cmar peroucty
[0 O S AR F i

| Truse:
Left

In "Design Setting" panel (only in Classical Template, in other templates, the colors will be
adjusted automatically based on your defined flash window color), you can set "Font color",
"Background color", "Background alpha" (refers to the background opacity, value interval:
0~1, "0" stands for the background is totally transparent), "Always Show Bookmark->True/
False" and "Panel Position->Left/ Right".

In "Bookmark" panel, if you didn't check "Import bookmark" option in "Import PDF"
interface, or you want to create new bookmarks for your flipbook, you can add bookmarks
even sub-bookmarks here, click "Add" icons and then input "Title" and "Page".

When click the bookmark button, it will popup the bookmark panel immediately, and

click on those bookmarks, it will jump to the defined page automatically

7. Links:

L

If you have check "Import links" option in "Import PDF" interface, then you can define
settings here, choose "Mouse over color", "Link alpha" (refers to the link area opacity, value
interval: 0~1, "0" stands for the area is totally transparent), "Border color", "Border width"
and "Open Window->Blank/ Self".
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8. Language
|_Language |English =]

You can set language for showing tools or tips in your created flipbook, and here is the
specialized instruction page for setting the "Language Option".

9. Security Settings:

[ Security Settings Single Pase ]

If you want to protect your flash books with passwords, you can click "..." icon to enter into

"Flash Security Config" interface:
(15 Flash security

Mobe
Sanghe' PEESvoded option Mesrn BhEt LSen need the pissvword 1o view the fash ook

Exclode Front Pages optin is o st a page number, all lafer pages can't be
vewd without Inputiing amerwesed

Seaxity Tyoe
4 Peo Sty
I 1

LS & Srmple Nasreed 111488

Probect Fage Rangd |
A Pages

& Exclude Front *ages Q

Select "Security Type->Single Password", and input passwords into the box (there is no
restriction on password format at present). You can also set "Protect Page Range" as "All
Pages" or the latter pages after a defined page number. (Tips: The program utilize RC4
algorithm to protect eBook pages, the eBook content pages will show nothing without
permission.)

ﬂ Apply Change

At last, click icon to apply the settings

IV. Language Options Interface

Click "Option->Flash Language", you will enter into the Language Settings interface as below
shows:
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e ——————
You can new or edit & language for the fash flipping book.
The Labled column below is the string that will be displayed in the fiash.
W The language will be st in the flash template settings
Language tame:[Chnese. v) [ % tentanguae| [ Hpeere | [Bsveos.] [ SGiewd.. |
Language Settings
| 1 —
Label Labled [ [P 59 = 1
Frst Button wm—@ |
Next Page Button T—m =
Last Button BE—Mm |
Pravicus Page Sutton B—a
Download Button T#
Print Button $TED
Search Button kS
Boak Mark Button =E
Help Button Eh
Enable FulScreen Button =R
Disable FullSoreen Button R
G o B b fImES £
[ = |G |

Panel Description:

As the tips explaining, the "Labled" column lists the buttons and instructions on Flash books
in defined language, and the program provides you five different languages for you to use:
English, Chinese Arabic, French and Greek.

Language Mame: im ish !’]

Arabic
Chinese
£ ||l
French
Greek

You can also add other language for your own uses:

-
1. Click the button [ s La”g”agEJ and define name for the new language:

i [ New Language ﬁ-‘

New Language |

D French

Click "OK" to save the new language in the list;

2. Choose the first label and click "Edit" icon, define new language text in "Labeled" box,
then click "Save And Edit Next":
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Kext Page Button

Last Button hast I Edti Language Item
| Previous Page Button Brevieus Pl —————————
Deveroad Button Dowvioed || St LEnuage Stritg |
| Frint Button Brint
Seardh Butten saareh Label:  Frstutton
Book Mark Button Book Mark
Help Button Help |abeled:  Presdére|
Enable FulSmeen Button  Enabis Fuls
Dizable FullScreen Button Disable Fuld
| B med S Busbbne Senmd D W
| swveandesimes | [ ox | | gonod

Joe

3. At last, you can get all Labels translated into your new language as the images shows:

Label

First Button

MNext Page Button

Last Button

Previous Page Button
Download Button

Print Button

Search Button

Book Mark Button

Help Button

Enable FullScreen Button
Disable Fullscreen Button

o imid P Bakbam

Labled

Premigre

Page suivante
Derniére

FPage précedente
Telécharger
Imprimer
Rechercher
Réservez Mark
Aide

Activer FullScreen

Désactiver FullScreen
| o Smamd

J Delete
You can delete unwanted language:

Or save your edited new language file as XML or TXT file:

33l Load.,
Load language file saving before for current using:
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V. Output Interface

=
{J§ FOF to FlsshBook Stendard Unrezistered — FOF to FlashBook Stenderd Overview
File Convert UOptions Help
1. Add Flie \ 2. Style J I 3. Publish
4 '
Qutput type
S @ * 0 g | e ¥ -
3 @ = html g e {o% 7 Texe ‘ ") %apn
[¥#] Also Make Mobile Version  Make output page-fiipping eBaok works on iPad, Phone and Android mobile devices
é How to make created eBooks svailable for others online?
Path
Output Folder: C:Users\Administrator \Documents Open
File Mame: index html
Options
HTML Title [ Advanced
[ |Burn to CD
Options
€D Writer [0;1:0,5: PLDS  DVD-ROM DH-16D55 VD15 I
Disc title:

[ Make it automatically play the fipbook in CD

Output types:

P oo

1.

This output type is for uploading created page-flipping ebook onto websites:

You can define HTML Title and other properties by clicking "Advanced" button:

Options

HTML Title: demo _g &dvanced]

Set Keywords, Description or even Script in the below interface:
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& Advanced Settings &
HTML Meta Settings
Title: demo

Keywords:  pdf, fipbook, page-fipping, ebaok, online, website, fiash, background, music

Description:  Mhis page-fipping eBook shows you the stunning flash effect on PDF pages, a

Add Scripts

You can put some tracking
code such as Google
Analytics here,

MNeed dosed <saipt>tag!

= )
_I 3 =
2. o

2.

This output type is for compressing the created files into an integral ZIP package which can
be sending out as attachment directly. You can also define HTML Advanced Settings by

clicking "Advanced" icon:

Your recipients just need to uncompress the ZIP file and then they can view the HTML
flipbook instantly:

| files

\Edemo.html

buuk.st

Uncompress

e
o @ *.exe
, W

This type is for outputting flipbook as a single executive file, easy storing and easy viewing:

You can also define Icon and Opening Window Size in Advanced Settings:
i B Advanced Settings ﬁ‘

Exe Advanced Settings

Exe Window Info

Caption;  dema
teon: [ (oo ] [ et ]

Window Size Option

) Maimized Custom Size

& Full Screen

e ] [ ]
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You can even burn the output flipbook to CD:

[¥]Burn to €D

CD Writer IU: 1:0;G: PLDS  DVD-ROM DH-16D55 VD15 VI

Disc title: |Page-Flipping eBook

[¥] Make it automatically play the fiphook in CD

After choosing output type, then check the option "Burn to CD", set "CD Writer", define

C i
"Disc title", at last click button to output flipbook in your defined type.

VI. Batch Convert Interface

K Batch Convert = =
0 add PDF Documents
A Add Fies ago Add Folder S Clheor A1
Mame Path
=Fip POF E:'isefiud Documents POFs Fip POF. pdf
JFip Printer Eriizefil Documents \POFs Flip Prnter pdf
A=Fip Word Erisefid Documents POFs o Word. pdf
= e — -

Cutput Setbings | POF Settngs |

Cutput type

T - P
;a’ = hemi % ~.zig TPl ® Texe
Path
Oytput Folder: O iUsers Wdmenistrator Deskoton | Browsa,. . Cpen
File plame: {PDF FilsMame) - eue
Fip PDF
Options
Cappon:  {PDF Tite} - |y Aebvanced)
Miaosoft Word - demo3L docx

Marge Al POF Files 1o One FlisBook
=8 Comvert bto Flash

| Conwert to Flash

Panel Description:

1. Add PDF Documents:
i AddFies |

Click this icon to add PDF files from computer;

g AedE | L this fcon to add all PDF files in the folder (include sub-folders).

You can also remove some unwanted PDF, move up/ down files, or clear all documents.
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% Remaove ﬁ Clear all -@ Move Lip @ Move Down

2. Settings:
(1). Output Settings:

i. Choose Output Type:

Output type

T :
__9 7 = html

ii. Choose Output Path:

a—

Path

Output Folder: ;::'l.l_.lsers'n,b.dminist'atorkpesktop I [ Browse. .. ][ Qpen l

You can also define output name pattern with FileName, Title, Subject and so on:

File Name: v

{PDF Title}
{PDF Subject}

{POF Author
OF FileMame

And after defining the File Name, you can preview the result example below:

File Mame: {PDF FileName} Flipping Bock =

Flip POF Flipping Book

iii. Define Output Option:
Options

Caption;  {PDF FileName} - |*‘:h Advanced

Flip POF

Click "Advanced" icon to define Keywords, Description for HTML flipbooks, or define Icon,
Window Size for EXE flipbooks:
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B Advanced Settings
[[Fm advanced settngs | |
HTML Méta Setangs

Toe: dems

Keywords:  paf, ipbook, page-fippng, ebock, orilng, webate, Sash, badkround, musc

Desoripton: | Mhes page-fipprg elook shows you the shuming flash effect on POF pages, 2

Add Sooh

Tou can put some: rackng
code such 25 Google
Analytes here.

Meed dosed cscript »tag!

ﬁ i 1§ Advanced Settings

Exe Advanced Settings
Exe Window Info
Cgption: demo

[m—:‘m s

Window Suze Cobon

Mawmired

) Full Sereen

iv. Merge All PDF Files to One Flip Book:

[¥1Merge All POF Files to COne FlipBooki

(2). PDF Settings:

i. Page Range:

The Page Ranges to Import
71 All pages

Example: 1,9-21,30

You can convert "All pages" or just "Custom range";

ii. Watermark:

Watermark
'n."" o Place a custom text or image
‘-_.? Watermark{Stamp) to the file{s)

gefait |

Click "Set Watermark" icon to enter into "Watermark" interface:

Cystom Spe
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Option “

Watermark
7] Applying Watermark
Watermark Name Type ™
IR Tt - CONFIDENTIAL Text
] A Text -Fiva Text -~
[] A Text - COMPLETED Text [z
[F] A Text - CRAFT Text

I 7] A Text - FOR PUBLIC RELEASE Text &

i [C] A Text - INFORMATTON ONLY Text =
|71 A Text - NOT FOR PUBLIC RELEASE Text
[T A Text - HOT APPROVED Text 5¢ N
1 = "
i A Text - Company(Tie) Text
E I A Text-LOGO {eft-top) Text & |
[T A Text -LOGO (Right-Top) Text
[F] A Text -LOGO (Left-Bottom) Text .
[7] A Text -LOGO (Right-Bottom) Text
I__- A Text - Dynamic - (tite) Text
[C] = image -L0GD Image .|

| [ o | [ cence |

Check "Applying Watermark" option, then you can choose default stamps, Edit them, or Add
Text Watermark, Add Image Watermark, Delete, Move Down/ Up.

iii. Page Quality:

L e e

larger file size
large file size
Medium guality medium file size
Low guality small file size
Lower quality smaller file size

Choose quality and size type from listed five kinds.

iv. Other Options:

[V]use first page's width and height as page proportion Select this option to use first page's

proportion as book proportion, or you can define in Template Setting interface;

et If your PDF file contains bookmarks, check this option to use in output

page-flipping eBook;
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I:H

[V tmpart finks If your PDF file has links, check this to enable in flipbook;

(S Enathle searcy Check this option to enable search functionality in created flipbook.

S

Convert to Flash

F K

At last, click icon to batch convert listed files together.

License Agreements

All copyrights to PDF to FlashBook Standard (the Software) are exclusively owned by
FlashBookMaker.com. For more information, visit our website at
www.FlashBookMaker.com .

Anyone may use this software but all the page-flipping eBooks generated will automatically
have a demo watermark on the first page of them. To remove the limitation you must
register.

Once registered, the user is granted a non-exclusive license to use the Software on one
computer (i.e. a single CPU) at a time. The registered Software may not be rented or leased,
but may be permanently transferred, if the person receiving it agrees to terms of this
license.

The Software unregistered (trial) version may be freely distributed, provided the distribution
package is not modified. No person or company may charge a fee for the distribution of the
Software without written permission from the copyright holder.
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THE SOFTWARE IS DISTRIBUTED "AS IS". NO WARRANTY OF ANY KIND IS EXPRESSED OR
IMPLIED. YOU USE AT YOUR OWN RISK. THE AUTHOR WILL NOT BE LIABLE FOR DATA LOSS,
DAMAGES, LOSS OF PROFITS OR ANY OTHER KIND OF LOSS WHILE USING OR MISUSING THIS
SOFTWARE.

You may not use, copy, emulate, clone, rent, lease, sell, modify, decompile, disassemble,
otherwise reverse engineer, or transfer the licensed Software, or any subset of the licensed
Software, except as provided for in this agreement. Any such unauthorized use shall result in
immediate and automatic termination of this license and may result in criminal and/or civil
prosecution.

All rights not expressly granted here are reserved by A-PDF Solution.

Installing and using the Software signifies acceptance of these terms and conditions of the
license.

If you do not agree with the terms of this license you must remove the Software files from
your storage devices and cease to use the product.

How to Order

Order Online (http://www.FlashBookMaker.com/flippingbook-maker/index.html) or Order

Toll Free 1-877-353-7297 (When you order toll free just give the operator the product
number of the product you would like).

How to purchase online?

1. Select a license type above, and click [Buy Now]

2. Select the currency that you want to use. (You can also continue shopping)

3. Fill billing information and select a payment method. (Your information is safe with us)

4. Check the information you filled previously and click "Place Secure Order"

Other Order Ways—With Phone/Mail/Fax/Check:
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If you are not comfortable ordering online witha credit card, you are welcome to choose an
offline order option in the payment section of the order process. We accept mail, fax, wire,
and PO (if applicable) ordering options in addition to ordering online. We also provide
phone orders through our 24x7 order desk at 1-877-353-7297, or (952) 646-5331 for
International Callers.

Please note that all of the offline ordering options do have additional fees for processing. To
place an order by mail, fax, wire, and PO (when applicable), use the online form and then
choose one of these payment options found in the Payment Method section of the form.
Once submitted online, the appropriate information will be provided to you in your web
browser to send your payment to us offline.

100% unconditional 30 Day Money Back Guarantee

Want to custom the program or have other questions about purchase?
Contact us at support@FlashBookMaker.com .

Support

You can easily search or browse our frequently asked questions, and learn tutorials about
products, and get your registration code back. If you don't get a satisfying solution, please
contact support team for help.

1. Frequently Asked Questions

You can find answers to questions about technique issues here:
http://www.FlashBookMaker.com/general-support.html

2. Learn tutorial about PDF to FlashBook Standard

We publish a video tutorial which shows you the easy procedure of dealing with PDF to

FlashBook Standard, you can view this video to quickly handle the stunning tool:
http://www.FlashBookMaker.com/flippingbook-maker/flippingbook-creator.swf

3. Get lost license code
Click here to look up the order » (http://www.regnow.com/cs/orderStatus)

You can pull up a copy of your order by entering your email address. After you find your
order, you may view its status, view details of your order (including the license key), and
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obtain the invoice.

4. Contact Us
If you have other questions or requirements, contact us directly through our support Email:
support@FlashBookMaker.com, we will respond you ASAP.
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